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RESUMO 

A urbanização é um evento de transformação de áreas rurais para áreas urbanas, normalmente 

ligado ao desenvolvimento da civilização e sequente migração populacional. Na implantação 

dos centros urbanos inicia-se o parcelamento do solo nativo por diversas unidades de terras 

fragmentadas, nesses processos as áreas naturais são ocupadas por superfícies impermeáveis. 

O Município de Palmas – TO apresenta problemas ambientais relacionados ao uso e ocupação 

irregular, como consequência, essa dinâmica exerce intensa pressão antrópica nas microbacias 

hidrográficas urbanas do município. Neste contexto, buscou-se disseminar o conhecimento 

sobre o controle de atividades antrópicas decorrentes da implantação dos centros urbanos. A 

presente pesquisa, analisou os padrões qualitativos e quantitativos dos corpos d’água e a 

dinâmica da evolução do uso e ocupação do solo das microbacias urbanas no período de 1988 

a 2020. A área de estudo é composta por 8 microbacias hidrográficas urbanas do Município de 

Palmas – TO, sendo córrego Cachimbo, Sussuapara, Brejo Comprido, Prata, Machado, Santa 

Barbara, Taquari e Cipó. As análises da qualidade da água foram realizadas em 24 pontos 

específicos distribuídos pelos córregos, em dois períodos do ano de 2021 (seco e chuvoso). 

Foram analisados os parâmetros: temperatura, condutividade elétrica, turbidez, sólidos totais 

dissolvidos, pH, demanda bioquímica de oxigênio, oxigênio dissolvido, amônia, nitrito, nitrato, 

fósforo total, Clorofila a, coliformes totais e Escherichia coli, de acordo com as condições e 

padrões de qualidade estabelecidos na Resolução CONAMA 357/05 para corpos hídricos de 

classe 2. Os aspectos hidrológicos foram avaliados pela medição das vazões em 8 pontos 

distribuídos pelos córregos, no período seco e chuvoso do ano de 2021. A dinâmica da evolução 

do uso e ocupação do solo foi realizada pela análise multitemporal das microbacias e suas APPs, 

nos anos de 1988, 1999, 2010 e 2020. Os resultados de qualidade da água mostram que os 

córregos urbanos possuem concentrações de Escherichia coli e coliformes totais acima dos 

limites permitidos para corpos d’água classe 2, conforme estabelece a Resolução CONAMA 

357/05, no período seco grande parte dos córregos possuem proporções de oxigênio dissolvido 

abaixo dos padrões da Resolução. A avaliação dos aspectos hidrológicos demonstra que no 

período de estiagem os córregos possuem redução do fluxo hidrográfico. Os resultados da 

avaliação espaço-temporal do uso e ocupação do solo mostram que o avanço urbanístico 

provocou alterações nas microbacias do estudo. Após a implantação do município as áreas de 

formações florestais reduziram continuamente no decorrer dos anos, à medida em que a área 

urbana se expandiu. Os procedimentos empregados no estudo denotam que a expansão urbana 

se sobrepôs em áreas com grau de proteção do solo, este cenário pode comprometer a 

manutenção ecológica natural das microbacias hidrográficas, limitando a provisão dos seus 

serviços ecossistêmicos.  

 

Palavras-chaves: Qualidade da água. Córregos urbanos. Monitoramento ambiental. Uso e 

ocupação do solo. Análise multitemporal. 

 

 

 

 

 

 

 

 

 



 

ABSTRACT 

Urbanization is an event of transformation from rural areas to urban areas, usually linked to the 

development of civilization and subsequent population migration. In the implementation of 

urban centers, the parceling of the native soil by several units of fragmented land begins, in 

these processes the natural areas are occupied by impermeable surfaces. The Municipality of 

Palmas - TO presents environmental problems related to the use and irregular occupation, as a 

consequence, this dynamic exerts intense anthropic pressure in the urban watersheds of the 

municipality. In this context, we sought to disseminate knowledge about the control of 

anthropic activities arising from the implementation of urban centers. This research analyzed 

the qualitative and quantitative patterns of water bodies and the dynamics of the evolution of 

land use and occupation in urban watersheds from 1988 to 2020. The study area is composed 

of 8 urban watersheds in the municipality of Palmas – TO, being Cachimbo stream, Sussuapara, 

Brejo Comprido, Prata, Machado, Santa Barbara, Taquari and Cipó. Water quality analyzes 

were carried out at 24 specific points distributed by streams, in two periods of the year 2021 

(dry and rainy). The following parameters were analyzed: temperature, electrical conductivity, 

turbidity, total dissolved solids, pH, biochemical oxygen demand, dissolved oxygen, ammonia, 

nitrite, nitrate, total phosphorus, Chlorophyll a, total coliforms and Escherichia coli, according 

to the conditions and quality standards established in CONAMA Resolution 357/05 for class 2 

water bodies. The hydrological aspects were evaluated by measuring the flows in 8 points 

distributed by the streams, in the dry and rainy period of the year 2021. The dynamics of the 

evolution of the use and Land occupation was carried out by multitemporal analysis of 

microbasins and their APPs, in the years 1988, 1999, 2010 and 2020.The water quality results 

show that urban streams have concentrations of Escherichia coli and total coliforms above the 

limits allowed for class 2 water bodies, as established by CONAMA Resolution 357/05, in the 

dry period most of the streams have proportions of dissolved oxygen below Resolution 

standards. The evaluation of the hydrological aspects demonstrates that in the dry season the 

streams have a reduction in hydrographic flow. The results of the spatio-temporal evaluation of 

land use and occupation show that urban advances caused changes in the studied watersheds. 

After the implantation of the municipality, the areas of forest formations continuously reduced 

over the years, as the urban area expanded. The procedures employed in the study denote that 

urban expansion overlapped areas with a degree of soil protection, this scenario may 

compromise the natural ecological maintenance of watersheds, limiting the provision of their 

ecosystem services.  

 

Keywords: Water quality. Quantitative aspects of water. Urban streams. Environmental 

monitoring. Land use and occupation. Urban microbasins. Multitemporal analysis. 
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1  INTRODUÇÃO 

A água é um recurso natural de domínio público essencial para a sobrevivência e bem-

estar populacional. Os recursos hídricos são os principais provedores de serviços ambientais 

fundamentais para o desenvolvimento econômico, preservação ambiental e qualidade de vida, 

seus diversos usos possibilitam diversas atividades, como: lazer, agricultura, consumo humano, 

transportes, abastecimento industrial, geração de energia, entre outras ações (UPRETY et al., 

2019). Neste sentido, o crescimento urbano associado ao desenvolvimento econômico 

populacional aumenta a demanda por recursos naturais. 

O avanço populacional exerce um impacto direto na qualidade da água de mananciais 

existentes em áreas urbanas. Tais impactos são influenciados pelo aporte de poluentes aos 

corpos hídricos que acabam comprometendo o processo de autodepuração desses mananciais 

pela acumulação e propagação de resíduos líquidos e sólidos (WANG; KIM; LI, 2021). Neste 

aspecto, o processo de despoluição das bacias hidrográficas urbanas resulta em alto custo para 

a sociedade inviabilizando o uso dos mananciais para fins de lazer e recreação, dentre outros 

(LIQUETE et al., 2011).   

Os conflitos ambientais são desencadeados, na maioria das vezes, durante a interação 

de atividades humanas com o meio ambiente, onde o uso e ocupação do solo é o principal 

provedor de mudanças e impactos ambientais nos ecossistemas, muitas vezes até irreversíveis 

(HOSSAIN; MONIRUZZAMAN, 2021). 

A implantação dos centros urbanos inicia-se a partir do parcelamento do solo, neste 

processo é realizada a alteração da superfície nativa por diversas unidades de terras 

fragmentadas, quando esse processo ocorre em ecossistemas com recursos hídricos superficiais, 

a possibilidade de degradação ambiental se torna inevitável, pois, na maioria das vezes, o 

manejo é realizado sem aplicação de práticas conservacionistas (TOLKKINEN et al., 2020). A 

tendência crescente da urbanização aumenta a demanda pelo uso e ocupação do solo, onde são 

implantadas as áreas com superfícies impermeáveis, habituais das obras civis urbanas, como, 

asfaltos, estradas, edifícios, residências e redes de drenagem (ZUHAL, 2016; ALVES; 

VOJINOVIC; KAPELAN, 2020). 

A cobertura vegetal exerce grande influência no comportamento hidrológico das 

microbacias hidrográficas, pois contribui para a infiltração da água no lençol freático, redução 

do escoamento superficial e processos erosivos, absorção da radiação solar, conservação da 

umidade no solo e equilíbrio climático (CORTELEZZI; BARRANQUERO; MARINELLI, 

2019). Quando a vegetação da microbacia hidrográfica é alterada, os recursos hídricos se 
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tornam vulneráveis à ocorrência de impactos ambientais negativos, como processos erosivos, 

assoreamento, aumento do escoamento superficial, carreamento de sedimentos, que são 

intensificados durante os fenômenos climáticos naturais, especialmente, as chuvas torrenciais, 

podendo resultar em enchentes, deslizamentos, entre outros.  

Com a necessidade de assegurar a proteção dos recursos hídricos de maneira sustentável 

foi instaurada Política Nacional de Recursos Hídricos como mecanismo de amparo pela Lei 

Federal nº 9.433, de 8 de janeiro de 1997, na qual refere-se em seu Art. 2º os objetivos desta 

lei:  

I - assegurar à atual e às futuras gerações a necessária disponibilidade de água, em 

padrões de qualidade adequados aos respectivos usos; II - a utilização racional e 

integrada dos recursos hídricos, incluindo o transporte aquaviário, com vistas ao 

desenvolvimento sustentável; e III - a prevenção e a defesa contra eventos 

hidrológicos críticos de origem natural ou decorrentes do uso inadequado dos recursos 

naturais (BRASIL, 1997, online). 

O Código Florestal Brasileiro define que as Áreas de Preservação Permanente – APP 

exercem a “função ambiental de preservar os recursos hídricos, a paisagem, a estabilidade 

geológica e a biodiversidade, facilitar o fluxo gênico de fauna e flora, proteger o solo e assegurar 

o bem-estar das populações humanas” (BRASIL, 2012, online). 

O monitoramento dos recursos hídricos é parte integrada do manejo ambiental, uma vez 

que a qualidade da água não está ligada apenas a finalidade de abastecimento da população 

humana, como também é de essencial importância para o desenvolvimento econômico, 

sobrevivência e qualidade de vida (UPRETY et al., 2019).  

De acordo com Risal et al., (2020) o conhecimento das tendências envolvidas na 

dinâmica de uso e ocupação do solo em áreas de preservação pode ser utilizado para estabelecer 

diretrizes para um desenvolvimento regional sustentável. A avaliação de cenários dinâmicos 

espaciais pode ser realizada por meio de dados de sensoriamento remoto e sistemas de 

informações geográficas, esses modelos possibilitam análises quantitativas e qualitativas de 

modificações espaço-temporais do uso e ocupação do solo, alterações vegetacionais, e outros 

(RWANGA; NDAMBUKI, 2017). 

Diante do exposto, o presente trabalho buscou estabelecer o marco referencial para as 

ações de monitoramento ambiental de qualidade e quantidade de água e avaliação das 

transformações espaço-temporais do uso e cobertura do solo das microbacias urbanas 

localizadas no Município de Palmas – TO, esta avaliação tem grande importância, haja visto 

que a cidade possui diversas áreas verdes distribuídas em sua extensão urbana e que apesar de 

ter sido projetada para ser uma cidade com desenvolvimento urbano ordenado e sustentável, o 
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avanço populacional acelerado do município tem desencadeado problemas ambientais 

negativos e exercendo intensa pressão antrópica nessas microbacias hidrográficas. 
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2 OBJETIVOS 

Tendo em vista que os serviços ambientais oferecidos pelos córregos urbanos são 

essenciais para a sobrevivência e bem estar populacional, existe a necessidade de estudos 

aprofundados que visem controlar os impactos ambientais decorrentes das ações antrópicas 

nesses meios.  

No intuído de disseminar o conhecimento sobre o controle de atividades antrópicas 

decorrentes da implantação dos centros urbanos, o presente estudo buscou realizar um 

monitoramento ambiental das microbacias hidrográficas urbanas do Município de Palmas – TO.  

Os objetivos específicos foram definidos com base nas pressões antrópicas em que as 

microbacias localizadas em áreas urbanas são submetidas, partindo deste princípio, adotados os 

seguintes objetivos específicos: 

• Diagnosticar a qualidade e quantidade dos recursos hídricos dos córregos urbanos 

do município; 

• Realizar uma análise multitemporal da evolução do uso e ocupação do solo das 

microbacias hidrográficas do município.  
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3 REVISÃO DA LITERATURA 

3.1 Bacias Hidrográficas  

As bacias hidrográficas são áreas de drenagem de um rio principal, seus afluentes e 

subafluentes. São delimitadas pelo relevo e geografia de uma unidade territorial e formadas 

pelos canais de escoamento natural da água dos corpos hídricos, água da chuva, nascentes, e 

lençol freático. Sendo assim, pode-se dizer que uma bacia hidrográfica é o conglomerado de 

todos os elementos de um rio e as áreas drenadas pelos cursos d'água.  

As bacias hidrográficas são a principais fontes de serviços ecossistêmicos, visto que 

proporcionam benefícios inestimáveis para o bem-estar, saúde, subsistência e sobrevivência 

humana (PEREDA et al., 2021). Elas podem ser definidas como áreas de absorção natural da 

água da chuva, que convergem o escoamento para um único ponto de saída, formando um 

conjunto de canais que se coligam com as redes de drenagem natural, que por fim são integrados 

em um leito singular (TUCCI, 1997). 

Durante o uso e ocupação de terra alteram-se significativamente os processos de 

absorção e infiltração do solo, atenuando o escoamento superficial durante as precipitações 

pluviométricas, ocasionando no carreamento de sedimentos até as bacias hidrográficas 

receptoras, possibilitando a ocorrência de processos erosivos, assoreamento e alteração da 

atividade biológica natural desses ambientes (KEMERICH et al., 2014).    

  Segundo Medeiros et al. (2009) estudos que abrangem o monitoramento de microbacias 

hidrológicas são de extrema importância, pois nesses ambientes tem se direcionado pouca 

atenção, a falta de monitoramento desses recursos está diretamente ligada à ocorrência de 

problemas ambientais em áreas urbanas, como a falta de água, além do mais, as microbacias 

oferecem contribuição aos grandes rios.   

3.1.1 Serviços Ambientais em Bacias hidrográficas  

As bacias hidrográficas oferecem de maneira natural pela distribuição geográfica 

diversos serviços ambientais, dentre eles, funções de ciclagem de nutrientes, produção de 

alimentos, disponibilidade de água doce, produção de madeira, carvão mineral, controle de 

inundações e espaços recreacionais de lazer (MARTIN, 2021).   

  Em termos práticos, as bacias hidrográficas podem ser definidas como um conjunto 

sistêmico, nos quais desempenham a distribuição de entrada de água das precipitações 
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pluviométricas e saída de água através do exultório, possibilitando a delimitação das bacias e 

sub-bacias, haja vista que as interligações se dão por meio dos sistemas hídricos, esses serviços 

ambientais são de extrema importância para os centros urbanos, pois influenciam no 

desenvolvimento econômico, social e populacional (KHAN et al., 2021).   

  Os serviços ambientais são processos exercidos cotidianamente pela natureza por meio 

dos ecossistemas, o crescimento urbano desordenado tem sido uma ameaça recorrente sobre os 

serviços ambientais oferecidos pelas bacias hidrográficas urbanas (CHEN et al., 2015).   

  Entre os instrumentos de gestão ambiental o termo do inglês “Nature-Based Solutions - 

NBS” indica um conjunto de práticas que consistem em ações de gerenciamento de forma 

sustentável voltados para a restauração dos ecossistemas naturais que foram modificados, onde 

o objetivo é deixar o próprio ambiente re-naturalizar, como exemplos, áreas verdes (jardins, 

pomares, corredores e parques); revegetação de matas ciliares, sistemas para controle de erosão, 

etc (CASTELLAR et al., 2021).  

3.1.2 Serviços Ecossistêmicos   

Os serviços ecossistêmicos são contribuições da natureza para a qualidade de vida, esses 

serviços são formados por processos ecológicos que contribui para a paisagem urbana, 

regulação de temperatura, produção de oxigênio, conservação de energia, escoamento de águas 

pluviais e atenuação de inundações, autodepuração natural da água, habitat das espécies 

selvagem e benefícios para a saúde física humana (CERRA, 2017).  

Segundo Alarsa et al. (2018) define-se os serviços ecossistêmicos com base na interação 

da sociedade com os recursos naturais, tais interações são a alavanca que impulsiona o 

desenvolvimento urbano em conjunto com a sustentabilidade ambiental, onde devem ser 

identificados os fatores de vulnerabilidade, prioridade, conflitos e alianças, capacidade de 

suporte dos estoques naturais em consonância com as necessidades e benefícios relativos ao ser 

humano e respectiva capacidade de recuperação e regeneração do sistema, aliando-se a força 

motriz social em consonância com as ações de manejo ambiental adequado. 

Millennium Ecosystem Assessment – MA foi um trabalho internacional iniciado em 

junho de 2001, coordenado pela United Nations Environment Programme - UNEP, a iniciativa 

teve como objetivo avaliar as consequências das alterações ecossistêmicas decorrentes das 

ações humanas e estabelecer uma base científica de ações necessárias para a melhoria da 

conservação e uso sustentável dos ecossistemas, o programa foi conduzido por cerca de 1.360 

especialistas de mais de 95 países, os relatórios resultantes da avaliação técnica do programa 
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foram publicados em meados de 2005, as principais conclusões dos resultados, indicam que nos 

50 anos antecedentes, os ecossistemas foram alterados pela humanidade de forma mais ampla 

e acelerada do que em qualquer outro período da história (MILLENNIUM ECOSYSTEM 

ASSESSMENT, 2005). 

Na síntese de Millennium Ecosystem Assessment (2005), define-se os serviços 

ecossistêmicos como procedimentos do ecossistema que suportam diretamente ou 

indiretamente o bem-estar populacional, sendo constituídos por 04 (quatro) categoria: Provisão; 

Regulação; Culturais e Suporte. A Figura 1 detalha a classificação dos serviços ecossistêmicos 

(MEA, 2005).   

Figura 1 - Classificação dos serviços ecossistêmicos 

Provisão Regulação Cultural Suporte 

Alimentos, matéria-

prima, fibras, fármacos 

naturais, recursos 

genéticos e bioquímicos, 

plantas ornamentais, água 

Purificação do ar, 

regulação do clima e 

ciclos da água, controle 

de enchentes; erosão; 

pragas; doenças, 

tratamento de resíduos 

Diversidade cultural, 

valores espirituais; 

religiosos; 

educacionais; estéticos, 

relações sociais, 

recreação e turismo.  

Ciclagem de 

nutrientes, produção 

primária, formação de 

solos, polinização, 

dispersão de sementes 

Fonte: Millennium Ecosystem Assessment (2005). 

 

  A consciência da necessidade de abordagens baseadas em processos de modelagem e 

interpretação dos serviços ecossistêmicos é crescente nos últimos anos (YANGA et al., 2021).   

  Pathak et al. (2020) argumentam que a avaliação de serviços ecossistêmicos possibilita 

estimar a profundidade do escoamento superficial e capacidade de infiltração em áreas urbanas. 

A alteração do ciclo hidrológico natural afeta diretamente nos serviços naturais que esses 

ambientes oferecem, uma vez que a biodiversidade é fundamental para a manutenção ecológica 

regular do ciclo de água e nutrientes (NIKA et al., 2020).  

3.2 Qualidade da Água 

Todos os seres vivos necessitam de água para sua sobrevivência e, para a população 

humana, a qualidade deste insumo é decisória no desenvolvimento social e econômico. A 

qualidade dos recursos hídricos vem sendo constantemente alterada ao longo dos anos, 

principalmente em córregos urbanos em decorrência das atividades humanas. Os cursos d'água 

são considerados importantes indicadores de qualidade ambiental, pois as ações antrópicas 
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praticadas em seu entorno refletem nitidamente na alteração de suas características físicas, 

químicas e biológicas (Tomazelli et al, 2015).  

O crescimento demográfico associado à deficiência no saneamento público vem 

comprometendo o funcionamento dos ecossistemas aquáticos. Muitos poluentes com misturas 

complexas e compostos biologicamente ativos são lançados nos corpos d´água sem o tratamento 

adequado, no qual contem grande quantidade de nutrientes, poluentes e desreguladores 

endócrinos (RICE; WESTERHOFF, 2017).  

As Estações de Tratamento de Esgoto – ETEs tem a função de tratar efluentes 

domésticos e industriais gerados a partir de atividades humanas, onde os são removidos os 

poluentes da água mediante aplicação de processos físicos, químicos e biológicos (GIRI, 2021). 

Apesar dessa finalidade, grande parte da poluição dos esgotos não são eliminadas 

completamente pelas ETEs, mesmo quando aplicadas as práticas terciarias, neste sentido, 

quando esses efluentes alcançam os corpos hídricos, ainda contêm uma ampla quantidade de 

substâncias químicas, incluindo nutrientes e matéria orgânica. Algumas dessas substâncias são 

tóxicas, como, metais pesados (DEYCARD et al., 2014), pesticidas, produtos de higiene 

pessoal e compostos farmaceuticamente ativos PHACs “PHarmaceutically active compounds”, 

que por sua vez, afetam a atividade biológica natural dos corpos hídricos (MANDARIC et al., 

2018).  

O estresse hídrico é um problema decorrente das mudanças climáticas e das captações 

de água. Durante períodos de baixo fluxo de água também reduz radicalmente a capacidade de 

autodepuração natural dos corpos hídricos, podendo ser evidenciados quando os corpos hídricos 

estão submetidos a fatores simultâneos, como o aumento da temperatura ou mudanças das suas 

vazões hidrológicas (SABATER et al., 2018).  

Em cenários de mudanças globais, sabe-se que os efluentes das estações de tratamento 

de esgoto compõem uma proporção bem maior de fluxo de água do que em muitos corpos 

hídricos receptores, deste modo, o uso exorbitante dos recursos hídricos ameaça diretamente 

esses meios naturais, tanto com compostos químicos quanto com os estressores hidrológicos 

(SKOULIKIDIS et al., 2017).  

A avaliação dos parâmetros físico-químicos e biológicos e o enquadramento dos corpos 

hídricos de acordo com a Resolução CONAMA 357/2005 (BRASIL, 2005) são ferramentas 

importantes para o diagnóstico ambiental possibilitando compreender os diferentes padrões de 

desenvolvimento urbano e a qualidade da água dos rios, direcionando o planejamento de ações 

de gerenciamento e controle da qualidade ambiental das águas superficiais. A seguir destaca-se 

os parâmetros avaliados no estudo.  
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3.2.1 Temperatura 

No Brasil não existe na legislação um valor definido para o parâmetro de temperatura 

dos corpos hídricos, apenas para o lançamento de efluentes, onde o limite fixado pela Resolução 

CONAMA nº 430/2011 é de até 40°C. A temperatura dos corpos hídricos é um importante 

parâmetro físico indicador de qualidade da água, quando associada a outros parâmetros, sendo 

muitas vezes, um fator limitante à vida aquática (PERCEBON et al., 2005). 

3.2.2 Condutividade 

A condutividade elétrica é um parâmetro capaz de demonstrar modificações na 

composição dos corpos hídricos, mas não especifica quantidades e componentes. Segundo 

Piratoba et al., (2017) não existe na legislação um padrão de condutividade em corpos hídricos, 

no entanto, em águas naturais a condutividade apresenta proporções entre 10 a 100 μS/cm, já 

em corpos hídricos poluídos por esgotos domésticos ou industriais essas proporções podem 

chegar até 1000 μS/cm.  

3.2.3 Turbidez 

O parâmetro de turbidez é a medição da resistência da água em relação a passagem de 

luz e está associado a presença de partículas em suspensão na água. O valor máximo permitido 

de turbidez na água distribuída é de 100 NTU, de acordo com corpos de água doce classe 2, 

estabelecidos na Resolução CONAMA 357/2005 (BRASIL, 2005). 

3.2.4 Sólidos totais dissolvidos 

O parâmetro Sólidos Totais Dissolvidos (STD) consistem na quantidade de sais 

inorgânicos e materiais dissolvidos na água, de acordo com corpos de água doce classe 2 

estabelecidos na Resolução CONAMA 357/2005 o valor máximo permitido consiste em 

500mg/L. 
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3.2.5 pH 

O parâmetro de pH é dado pela atividade do íon hidrogênio (H+), sua escala indica se o 

meio é ácido, básico ou neutro.  

3.2.6 Demanda bioquímica de oxigênio 

O parâmetro demanda bioquímica de oxigênio (DBO) é relacionado a eficiência da 

decomposição da matéria orgânica na água, no qual corresponde à quantidade de oxigênio 

consumido durante a oxidação da matéria orgânica. A Resolução CONAMA 357/2005 

estabelece o valor máximo permitido de DBO em até 5,0 mg/L para corpos d’água doce classe 

2.  

3.2.7 Oxigênio dissolvido 

O parâmetro oxigênio dissolvido (OD) se refere a medida da saturação da quantidade 

de oxigénio dissolvido na água. O OD é essencial para a sobrevivência das espécies aquáticas, 

de acordo com a Resolução CONAMA 357/2005 esse parâmetro deve ser > 5,0 mg/L.  

3.2.8 Fósforo total 

O parâmetro fósforo total é um importante indicador de qualidade da água dos 

mananciais, pode ser encontrado em diversas formas, como ortofosfatos, polifosfatos e fósforo 

orgânico. O fósforo é composto de materiais sedimentáveis que chegam até os corpos d’água 

pela dissolução de rochas, escoamento de águas pluviais, despejo de esgotos e carreamento de 

sedimentos de terras agrícolas adubadas. Elevadas concentrações desse nutriente na água 

podem causar a proliferação exagerada de algas desencadeando processos de eutrofização.  

3.2.9 Clorofila-a 

O parâmetro Clorofila a indica as alterações da cor e dos pigmentos clorofilianos da 

água. A Resolução CONAMA 357/2005 estabelece o valor máximo permitido de 30,0 µg/L 

para corpos d’água doce classe 2.  
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3.2.10 Coliformes totais 

Os coliformes termotolerantes são indicadores de contaminação por bactérias presentes 

na água. Essas bactérias estão presentes estão presentes no intestino de animais de sangue 

quente e dos seres humanos, e são indicadores de contaminação por fezes na água.  

A Escherichia coli é uma espécie de bactéria do grupo dos coliformes termotolerantes, 

sendo considerada a melhor indicadora de poluição fecal na água.  

Falta indicar a fonte das informações acima. 

3.3 Comportamento Hidrológico dos Córregos Urbanos 

Os corpos hídricos são canais naturais de drenagem de água que instauram as bacias 

hidrográficas, caracterizam-se como sulcos naturais que formam um sistema hídrico 

indispensável para a manutenção das bacias, o seu comportamento oscila de acordo com o uso 

do solo, tamanho, geologia, topografia, condições climáticas e forma das áreas de drenagem 

(MELO et al., 2020).  

  Na pesquisa de Dar, Shah e Bhat (2019) relata-se que as infraestruturas azul e verde, do 

termo BGI “Blue Green Infrastructure”, são um conjunto de sistemas naturais de uma cidade, 

que oferecem vários serviços de natureza intangível à população, que contribuem 

significativamente para o comportamento hidrológico das bacias hidrográficas, auxiliando na 

manutenção dos serviços ecossistêmicos, conforto e redução de ruído nas vias urbanas, 

melhoria da qualidade do ar, melhoria da saúde física e mental da população, redução na 

geração de gases de efeito estufa e melhoria da qualidade ambiental. 

Para Oliveira et al. (2020) as atividades de supressão vegetal, uso e ocupação do solo, 

alterações geológicas e avanço demográfico desordenado, ou seja, sem a aplicação de práticas 

conservacionistas, estão totalmente relacionadas ao comportamento hidrológico desenvolvido 

pelos córregos urbanos.  

  Na implantação dos centros urbanos criam-se as superfícies impermeáveis, ocasionando 

na expansão das redes de drenagem superficial (GIRI, 2021). Essas áreas popularmente 

conhecidas como infraestruturas cinzas, podem desencadear diversos problemas ambientais em 

termos hidrológicos, haja vista que essas superfícies contribuem para o escoamento superficial, 

aumento a incidência de processos erosivos, danos a qualidade da água e risco de inundações 

(BEDLA et al., 2021). 
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A vazão hidrológica de um corpo hídrico é mais estável e sustentável em bacias com 

maior cobertura vegetal, pois as matas ciliares favorecem a estabilidade dos solos nas áreas 

marginais, contribuindo para um comportamento hidrológico com maior infiltração e 

consequentemente, na redução do escoamento. Segundo Santos, Griebeler e Oliveira (2010), as 

mudanças de uso do solo e do clima exercem grande influência no comportamento hidrológico 

das bacias hidrográficas.  

3.4 Uso e Ocupação do Solo  

As mudanças de uso e ocupação do solo são eventos habituais na implantação e 

crescimento dos centros urbanos, essas práticas estão entre os principais impulsionadores de 

degradação ambiental de bacias hidrográficas urbanas (BRANCHET et al., 2021). 

O processo de uso e ocupação do solo em função da urbanização consiste na retirada da 

cobertura vegetal nativa para implantação das áreas com superfícies impermeáveis, essas 

atividades alteram consideravelmente a capacidade de absorção e infiltração do solo. A 

expansão demográfica associada ao desenvolvimento econômico, impõem uma influência cada 

vez maior sobre os recursos naturais. As áreas de preservação permanente – APP dos cursos 

d’água se tornam suscetíveis a intervenções humanas, através da supressão da vegetação nativa 

para uso e ocupação do solo, despejo de esgoto, canais de drenagem e manejo irracional 

(MATIELLO et al., 2017). 

O novo Código Florestal Brasileiro instituído pela Lei nº 12.651/12, art. 3º, inciso II, 

define Área de Preservação Permanente como: 

Área de Preservação Permanente - APP: Área protegida, coberta ou não por 

vegetação, com a função ambiental de preservar os recursos hídricos, a paisagem, a 

estabilidade geológica e a biodiversidade, facilitar o fluxo gênico de fauna e flora, 

proteger o solo e assegurar o bem-estar das populações humanas (BRASIL, 2012). 

 

O Código Florestal considera Área de Preservação Permanente, em zonas rurais ou 

urbanas, as faixas marginais de qualquer curso d’água natural perene e intermitente, 

excluídos os efêmeros, desde a borda da calha do leito regular, em largura mínima de: 

a. 30 (trinta) metros, para os cursos d’água de menos de 10 (dez) metros de largura; 

b. 50 (cinquenta) metros, para os cursos d’água que tenham de 10 (dez) a 50 

(cinquenta) metros de largura; 

c. 100 (cem) metros, para os cursos d’água que tenham de 50 (cinquenta) a 200   

(duzentos) metros de largura; 

d. 200 (duzentos) metros, para os cursos d’água que tenham de 200 (duzentos) a 600 

(seiscentos) metros de largura; 

e. 500 (quinhentos) metros, para os cursos d’água que tenham largura superior a 600 

(seiscentos) metros de largura (BRASIL, 2020, online). 
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As matas ciliares adjacentes aos cursos d'água influenciam diretamente na qualidade da 

água doce disponíveis nos mananciais, ajudando a proteger o ecossistema das atividades 

antropogênicas que ocorrem nas bacias hidrográficas. Valera et al. (2019) apontam que, além 

da proteção, as matas ciliares fornecem vários serviços, como habitat para espécies, 

biodiversidade do solo, filtragem de sedimentos, controle de inundações, estabilidade do canal 

dos corpos hídricos e manutenção dos aquíferos. 

A Figura 2 demonstra um esquema representativo dois métodos de urbanização, um com 

aplicação de práticas conservacionistas e outro a utilização de práticas de conservação.  

Figura 2 - Esquema representativo de métodos de urbanização 

  

Fonte: Autora (2022).  

3.5 Monitoramento espaço-temporal  

A aplicação do sensoriamento remoto é amplamente utilizada para se avaliar fatores 

ambientais, uma vez que as análises espaciais geograficamente referenciadas oferecem uma 

técnica altamente valiosa no monitoramento ambiental (KOTARIDIS; LAZARIDOU, 2018). 



26 

 

 

O sensoriamento remoto possibilita um melhor conhecimento e o manejo da vegetação 

das matas ciliares, fornecendo dados econômicos e espacialmente contínuos em uma ampla 

extensão, contribuindo para a capacidade de se adquirir dados em grandes extensões. Nas 

últimas décadas, no uso do sensoriamento por sensores, vetores e poder computacional, 

permitiu-se o desenvolvimento de aplicações em ciências ambientais. A utilidade das 

ferramentas de sensoriamento remoto em matas ciliares, já foram evidenciados desde 2010 

(MÜLLER, 1993).  

A plataforma MapBiomas é uma iniciativa multi-institucional que envolve ONGs, 

empresas de tecnologia e universidades. A plataforma desenvolve projetos de mapeamentos 

anuais por meio de processamento em nuvem e classificadores mecanizados que operam a partir 

da plataforma Google Earth Engine, gerando séries históricas de mapas anuais de do uso e 

cobertura do solo do Brasil. 

Para Kumar et al. (2021), concluem-se que o avanço nas tecnologias de sensoriamento 

remoto aerotransportado e acompanhamento por imagens de satélite, são um avanço no 

monitoramento sistemático do desempenho das soluções baseadas na natureza. No trabalho de 

Lu et al. (2004) descreve-se que na utilização de métodos de sensoriamento remoto existem 

várias abordagens na detecção de mudanças no uso e ocupação do solo, mudanças de vegetação, 

mudanças urbana e mudanças de cobertura florestal. 

Para Khair et al. (2021) o monitoramento em conjunto com a participação da 

comunidade, incentiva a participação das partes interessadas, de forma a ampliar sua 

autonomia, envolvimento e consciência, possibilitando um melhor apoio e fortalecimento da 

sustentabilidade ambiental na região.  

As abordagens e ferramentas disponibilizadas pelos dados de sensoriamento remoto 

permitem a caracterização de todos os tipos de vegetação de uma bacia hidrográfica, desde o 

conciso delineamento das áreas de preservação permanente, estruturas e fisiologia, sendo um 

dos principais avanços agregados ao monitoramento ambiental nas últimas décadas (DUFOUR 

et al., 2013).  

Uma melhor adaptação dos processos de planejamento espacial integrado, maiores 

oportunidades para os tomadores de decisão e cooperação institucional mais rápida são 

elementos importantes que permitem que este desafio seja enfrentado (ÇETIN et al., 2018). 

Segundo Cui et al. (2019), o sensoriamento remoto é uma tecnologia que fornece dados 

com mais cobertura espacialmente homogênea e temporalmente completa. Com os recursos do 

sensoriamento remoto, grande parte das variações integrantes aos processos ambientais da água, 
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são observáveis em resolução e precisão de espaço-temporal, ou seja, é possivel verificar com 

antecedencia ocorrencias como: armazenamento água,  precipitação, neve e gelo.  

Para Sepuru e Dube (2018) um dos principais benefícios do sensoriamento remoto são 

os índices de propagação da cobertura vegetal resultantes das imagens de satélite, sendo uma 

abordagem presente no mapeamento, que torna capaz a obtenção de informações sobre as 

reflectâncias das superfícies da Terra.   

Pra Cruz et al., (2021), as técnicas de sensoriamento remoto são os métodos mais 

frequente na análise do valor ecológico, as principais aplicações do uso desse desfecho foram 

no planejamento natural e urbano, conservação da biodiversidade e remuneração por serviços 

ecossistêmicos. Ghassemian (2016) discorre que quando os estudos com aplicação do 

sensoriamento remoto registraram características funcionais, dificilmente se usam dados de 

trabalho de campo, isso certamente se deve ao aumento nas habilidades e confiabilidade das 

imagens de satélite sequenciadas por meio das estratégias de sensoriamento remoto.  
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4 MATERIAIS E MÉTODOS   

4.1 Localização e Caracterização da Área De Estudo 

A área de estudo é distribuída pela região urbana do Município de Palmas – TO, 

composta por 8 microbacias hidrográficas denominadas, Córrego Cachimbo, Córrego 

Sussuapara, Córrego Brejo Comprido, Córrego do Prata, Córrego Machado, Córrego Santa 

Bárbara, Córrego Taquari e Córrego Cipó. As microbacias objetos deste estudo estão inseridos 

na Bacia Hidrográfica do Rio Tocantins.  

Criada em 20 de maio de 1989, a cidade de Palmas é estabelecida à margem direita do 

reservatório formado pela Usina Hidrelétrica Luís Eduardo Magalhães – UHE Lajeado, cuja 

área territorial do município é de cerca de 2.227 km² e população estimada 313.349 habitantes 

(IBGE, 2021). O clima predominante no Estado do Tocantins é o tropical, segundo a 

classificação de Köppen-Geiger ele apresenta estação chuvosa durante o verão, nos meses de 

novembro a abril, e estação seca no período de inverno, nos meses de maio a outubro, as 

temperaturas médias anuais variam entre 22°C e 27°C e a precipitação média anual varia entre 

600 e 2.000 mm (MMA, 2007). A Figura 3 mostra a localização das microbacias hidrográficas 

do estudo em relação ao Município de Palmas, Estado do Tocantins e Brasil.  

Figura 3 - Localização das Microbacias hidrográficas de estudo. 

 
        Fonte: Autora (2022). 
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As principais características das microbacias hidrográficas do estudo podem ser 

visualizadas na Tabela 1. 

Tabela 1 - Características das microbacias hidrográficas do estudo. 

Microbacia hidrográfica Extensão (m) Área (km²) APP (m) Abrangência urbana 

Córrego Cachimbo 2770 5.12 42 m Integral 

Córrego Sussuapara 4690 11.29 42 m Integral 

Córrego Brejo Comprido 12580 48.88 42 m Parcial 

Córrego do Prata 2828 17.46 42 m Integral 

Córrego Machado 5900 11.78 42 m Integral 

Córrego Santa Bárbara 5850 13.18 42 m Integral 

Córrego Taquari 11300 20.41 42 m Parcial 

Córrego Cipó 7800 25.45 42 m Parcial 

Fonte: Autora (2022). 

Para a escolha dos corpos hídricos do estudo utilizou-se critérios de inclusão, tendo 

como fator principal os córregos com maior abrangência territorial dentro do perímetro urbano 

do Município de Palmas. As microbacias dos Córregos Brejo Comprido, Taquarí e Cipó 

possuem uma pequena parte de sua extensão territorial localizada em área rural, todavia, tal 

inclusão foi efetivada, haja vista a grande valia desses recursos hídricos para a sociedade, nos 

quais oferecem serviços ecossistêmicos e socioambientais essenciais para qualidade de vida e 

bem-estar populacional.  

A Figura 4, apresenta um diagrama esquemático com os passos do desenvolvimento da 

metodologia. 

Figura 4 - Representação esquemática do desenvolvimento da metodologia. 

 
           Fonte: Autora (2022). 
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4.2 Análise da Qualidade da água 

Para os procedimentos do estudo foram analisados os parâmetros físico-químicos e 

biológicos dos córregos urbanos conforme os padrões de qualidade aplicáveis a águas doces 

classe 2, estabelecidos na Resolução CONAMA n° 357/2005 (BRASIL, 2005).  

Os parâmetros físicos, químicos e biológicos são importantes indicadores qualidade das 

ambiental, pois, possibilitam compreender a relação dos diferentes padrões de desenvolvimento 

urbano associados as condições das águas superficiais (PELUSO et al., 2021).  

As amostras de água foram coletadas em dois períodos climáticos, em 24 (vinte e quatro) 

pontos distribuídos pelos 08 (oito) córregos urbanos. Os pontos de coleta estão apresentados na 

Figura 05. 

Figura 5 - Pontos de coleta de água.

 
      Fonte: Autora (2022) 

Os pontos de coleta de água foram determinados de acordo com os fatores antrópicos 

locais, como exemplo: contribuição de vias urbanas, lançamento de drenagem, pontos de 

drenagem, lançamento de efluentes e pontes sobre cursos d’água. A Figura 6 mostra a 

distribuição dos pontos de contribuições urbanas locais em relação aos corpos hídricos. 
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Figura 6 – Contribuição urbana 

 
              Fonte: Autora (2022). 

As análises de qualidade da água foram realizadas em duas campanhas de 

monitoramento durante o ano de 2021. A primeira campanha foi executada no mês de abril 

durante o período chuvoso e a segunda foi realizada no mês outubro, na estação de seca.  

As análises de qualidade da água foram realizadas pelo Laboratório de Pesquisa em 

Química Ambiental e Biocombustível – LAPEQ da Universidade Federal do Tocantins – UFT 

Câmpus de Palmas, os técnicos do laboratório realizaram a coleta das amostras acompanhados 

pela autora. Em cada local de colhimento foi registrado um ponto de coordenada geográfica 

utilizando o aparelho GPS (Modelo Garmim Etrex), bem como todos os dados foram subscritos 

em planilha de campo. Todos os parâmetros foram analisados de acordo com a metodologia 

proposta por Standard Methods for the Examination of Water and Wastewater (APHA, 2005) 

(QUADRO 1).  
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Quadro 1 – Métodos adotados e VMP para os parâmetros analisados 

Parâmetros 
CONAMA 357/2005 

VMP² 
Técnica – Referência 

Temperatura (°C) * Medida Direta – APHA (2005) 

Condutividade Elétrica (µS/cm) * Medida Direta – APHA (2005) 

Turbidez (NTU) 100 Medida Direta – APHA (2005) 

Sólidos Totais Dissolvidos (mg/L) 500 Medida Direta – APHA (2005) 

pH (Escala) 6,0 a 9,0 Medida Direta – APHA (2005) 

Demanda Bioquímica de Oxigênio (mg/L) 5,0 Diferenciação – APHA (2005)) 

Oxigênio Dissolvido (mg/L) > 5,0 Medida Direta – APHA (2005) 

Amônia (mg/L) *** Espectrofotometria – APHA (2005) 

Nitrito (mg/L) 1,0 Espectrofotometria – APHA (2005) 

Nitrato (mg/L) 10,0 Espectrofotometria – APHA (2005) 

Fósforo total (mg/L) 0,10 Espectrofotometria – APHA (2005) 

Clorofila a (µg/L) 30,0 Espectrofotometria – APHA (2005) 

Coliformes totais (NMP/100 mL) * Colilert – APHA (2005) 

Escherichia coli (NMP/100 mL) 1.000 (3) Colilert – APHA (2005 

Fonte: Autora (2022). 

4.2.1 Análise in situ e ex situ  

Os parâmetros de temperatura, condutividade elétrica, turbidez, sólidos totais 

dissolvidos, pH e oxigênio dissolvido foram avaliados in loco com aparelhos portáteis de 

medição, devido à suscetibilidade a alterações. Em seguida foram coletadas as amostras de água 

para análise ex situ dos parâmetros de demanda bioquímica de oxigênio, amônia, nitrito, nitrato, 

fósforo total, Clorofila a, coliformes totais e Escherichia coli. As amostras foram etiquetadas e 

armazenadas em recipientes esterilizados fornecidos pelo laboratório, em seguida 

acondicionadas em caixas térmicas e transportadas até o local de análise.  

4.3 Aspectos Hidrológicos dos Córregos Urbanos  

Afim de avaliar o comportamento hidrológico dos córregos urbanos em ambos os 

períodos climáticos do estado, foram realizadas duas campanhas de medições das vazões 

durante o ano de 2021. As medições foram realizadas em um único ponto definido na foz de 

cada córrego, devido a maior concentração do fluxo hidrográfico nestas zonas. Assim como as 

análises de qualidade da água, a avaliação dos aspectos hidrológicos foi realizada no mês de 

abril no período chuvoso e no mês outubro no período de estiagem. A Figura 7 demonstra os 

pontos de medições de vazões.  
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Figura 7 - Pontos de medição de vazões 

 
       Fonte: Autora (2022). 

Utilizou-se o Equipamento FlowTracker serial P5001/ CPU Firmware Version 3.9 

software version 2.30/Mounting Corretion 0.0%, para a medição da vazão dos Córregos: 

Cachimbo, Sussuapara, Brejo Comprido, Machado, Santa Barbara, Taquarí e Cipó. Conforme 

especificações técnicas do equipamento, o mesmo é indicado para medição de vazão com até 1 

metro de profundidade, fluxo linear homogêneo e de pouca turbulência.  

A medição da vazão do Córrego do Prata foi realizada com o equipamento SonTek 

RiverSurveyor® S5 and M9 (U.S) (Patent 8, 125, 849), de acordo com especificações técnicas 

do equipamento, o mesmo é ideal para medição de corpos hídricos com profundidade acima de 

01 metro, sendo uma característica identificado preliminarmente no Córrego do Prata em ambas 

as estações. Os equipamentos foram disponibilizados pela Secretaria de Meio Ambiente e 

Recursos Hídricos - SEMARH do Estado do Tocantins. Na Figura 8 pode ser visualizado os 

equipamentos utilizados.  
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      Figura 8 - Equipamentos de medições de vazões 

  
a) Flowtracker serial P5001 b) Sontek riversurveyor M9 

Fonte: Autora (2022) 
 

4.4 Análise Multitemporal da Evolução do Uso e Ocupação do Solo (1988 a 2020)  

A análise multitemporal consistiu em avaliar a evolução do uso e ocupação do solo das 

microbacias hidrográficas urbanas e suas áreas de preservação permanente – APP, entre os anos 

de 1988, 1999, 2010 e 2020. 

Para os procedimentos da análise foram utilizados dados de sensoriamento remoto, 

sistemas de informações geográficas e o software ArcGis 10.7. 

4.4.1 Estruturação dos dados e esquematização cartográfica 

Para a caracterização da dinâmica de uso e ocupação do solo e determinação das taxas 

de transformações ocorridas por período avaliado, utilizou-se dados de sensoriamento remoto, 

sistemas de informações geográficas e o software ArcGis 10.7. A base de dados geoespaciais 

das imagens de satélite e vetores foram obtidos pelo Instituto de Natureza do Tocantins – 

NATURATINS, Secretaria do Planejamento e Orçamento – SEPLAN/TO, Sistema de 

Informações Geográficas de Palmas – GEOPALMAS e Ministério da Agricultura Pecuária e 

Abastecimento – MAPA. Os mapas de cobertura e uso da terra foram obtidos na Plataforma 

digital MapBiomas. 

O banco de dados espaciais foi construído no software ArcGis 10.7 Desktop. O software 

possibilitou a produção dos elementos e esquematização cartográfica, foi utilizado o sistema de 

referência SIRGAS-2000 (Sistema de Referência Geocêntrico para as América) no manuseio 

e projeção dos dados. Posteriormente, foi realizado o tratamento e ordenamento desses dados 

em forma de mapas nas escalas 1:2.000.000, 1:1.000.000, 1:100.000, 1:80.000, 1:60.000, 
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1:50.000 e 1:30.000. Os dados permitiram a qualificação e quantificação espaço-temporal das 

variações de uso e cobertura do solo das microbacias hidrográficas. 

4.4.2 Mapeamento  

Nessa etapa realizou-se a extração de drenagens e delimitação das bacias a partir do 

processamento de uma imagem de modelo digital de elevação (MDE) obtida a partir dos dados 

do SRTM do inglês “Shuttle Radar Topography Mission”, o mapeamento dos canais de 

drenagem foi realizado com auxílio do software ArcGis 10.7, na extensão do ArcMap > Spatial 

Analyst Tools > Hydrology > Fill. Posteriormente, foi gerado um arquivo em formato raster 

com a direção do fluxo no caminho ArcToolbox, extensão Spatial Analyst Tools > Hydrology 

> Flow Direction, em seguida, no arquivo raster direção gerou-se o fluxo acumulado na 

extensão Spatial Analyst Tools > Hydrology > Flow Accumulation.  

Em seguida foi gerado um arquivo raster com as drenagens extraídas em ArcToolbox > 

Spatial Analyst > Conditional > Con. Sequentemente foi criado o arquivo shape das drenagens 

em ArcToolbox > Spatial Analyst Tools > Hydrology > Stream to Feature. Em seguida foram 

delimitadas as microbacias hidrográficas a partir de um shape de ponto aplicando a extensão 

ArcToolbox > Spatial Analyst Tools > Hydrology > Watershed. Feito isso, a microbacia 

delimitada foi transformada para o formato de polígono no caminho ArcToolbox extensão 

Conversion Tools > From Raster > Raster to Polygon. Esse procedimento foi realizado para 

delimitação de todas as microbacias.  

As áreas de preservação permanente dos 08 córregos urbanos foram mapeadas 

utilizando a base de dados vetoriais disponibilizada no Sistema de Informações Geográficas de 

Palmas – GEOPALMAS, pois o município possui legislação específica para a delimitação das 

áreas de preservação permanente – APP dos cursos d’água na sua esfera de sua competência, 

instituída pela Lei Complementar Nº 400, de 2 de abril de 2018 (PALMAS, 2018).  

Para a qualificação e quantificação dos índices de evolução do uso e ocupação do solo, 

foram obtidos 4 mapas da Plataforma digital MapBiomas com abrangência do Município de 

Palmas, os arquivos são imagens classificadas da coleção 6 do satélite Landsat, possuem 

formato matricial (raster) (pixel de 30x30m) e resolução espacial de 30 m (publicada em agosto 

de 2021, cobrindo o período de 1985 – 2020). As imagens utilizadas correspondem aos anos de 

1988, 1999, 2010 e 2020. 

Em seguida, realizou-se o recorte das imagens classificadas da plataforma MapBiomas 

de acordo com a geometria da área de estudo. Primeiramente foi feito o recorte das imagens em 
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relação a área de todas as microbacias, com auxílio do software ArcGis 10.7, no caminho 

ArcToolbox, na extensão > Data Management Tools > Raster Processing > Clip. 

Logo após, foram reagrupadas as classes menos frequentes do recorte da área de estudo 

e reclassificadas para melhor interpretação, aplicando a extensão ArcToolbox > Spatial Analyst 

Tools >Reclass >Reclassify. 

Feito isso, os mapas em formato raster foram convertidos para o formato de vetor, na 

extensão ArcToolbox > Conversion Tools > From Raster > Raster to Polygon. Seguidamente, 

realizou-se o recorte dos arquivos vetoriais em relação a cada microbacia em ArcToolbox > 

Analysis Tools > Extract > Clip. Sequentemente, calculou-se as áreas das microbacias, das 

classes uso e ocupação do solo e seus percentuais.  

4.4.3 Análise Multitemporal da Evolução do Uso e Ocupação do Solo 

As imagens classificadas da plataforma MapBiomas possibilitaram a extração das 

classes de uso e cobertura do solo da área de estudo, onde cada feição possui um identificador 

aliado a uma legenda.  

O corte das 08 microbacias demonstrou 10 classes de uso e ocupação do solo, sendo: 

Formação Florestal (3); Formação Savânica (4); Campo Alagado e Área Pantanosa (11); 

Formação campestre (12); Pastagem (15); Mosaico de Agricultura e Pastagem (21); Área 

Urbanizada (24); Outras áreas não vegetadas (25); Mineração (30) e Corpos D’água (33). No 

entanto, as classes menos frequentes foram reorganizadas em 5 grupos, para melhor 

interpretação. O Quadro 2 demonstra a reorganização das classes. 

Quadro 2 – Classes de uso e ocupação do solo do campo de estudo. 

Classes de uso e ocupação do solo Aspectos e reorganização 

Formação Florestal (3) 
Formação Savânica (4), Campo Alagado e Área Pantanosa (11), 

Formação campestre (12). 

Pastagem (15) Mosaico de Agricultura e Pastagem (21). 

Área Urbanizada (24) Área urbanizada composta pelo município de Palmas, Mineração (30). 

Área não Vegetada (25) Predomínio de superfícies não vegetadas. 

Corpos D’água (33) Rios, lagos e reservatórios 

Fonte: MapBiomas (2021), adaptado pela Autora. 
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5 RESULTADOS E DISCUSSÃO   

5.1 Avaliação da Qualidade da Água   

Neste tópico serão demonstrados os resultados das análises de qualidade da água dos 

córregos urbanos do estudo conforme condições e padrões aplicáveis a águas doces classe 2, 

estabelecidos na Resolução CONAMA 357/2005. 

5.1.1 Córrego Cachimbo 

O Córrego Cachimbo é localizado na região norte de Palmas -TO, as áreas entorno desse 

manancial possuem grande ocupação urbana e uso do solo desordenado, no ponto de coleta P1 

verificou-se um aterramento do seu leito que impossibilitava o seguimento do fluxo natural da 

água. 

Na Tabela 2 demonstra-se o resultado das análises laboratoriais no período chuvoso (C) 

e de seca (S). Os dados mostram que os parâmetros de turbidez, sólidos totais dissolvidos, 

demanda bioquímica de oxigênio, nitrito, nitrato e Clorofila a se mantiveram dentro dos 

padrões estipulados na Resolução CONAMA nº 357/2005 nas duas campanhas.  

No período de estiagem não havia água no ponto P1, nos demais pontos (P2, P3 e P4) 

as concentrações de oxigênio dissolvido (OD) está abaixo dos padrões preconizados pela 

Resolução CONAMA 357/2005, este parâmetro é fundamental para sobrevivência dos seres 

aquáticos. Valores negativos de OD podem estar relacionados a elevada concentração de 

matéria orgânica na água, nesses pontos haviam várias canalizações saindo das habitações as 

margens da microbacia, nas quais faziam lançamentos de efluentes domésticos no leito do 

córrego.  

 O pH teve valores ligeiramente inferiores ao padrão para corpos d’água de classe 2 no 

período chuvoso nos pontos P2, P3 e P4. As análises do parâmetro coliformes totais 

apresentaram valores superiores a 1299,0 NMP/100 mL em todas as amostras e períodos. No 

Ponto P2 (S) a Escherichia coli teve concentrações acima de 1000 NMP/100 mL, sendo 

excedente ao limite da resolução.  
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Tabela 2 - Qualidade da água do Córrego Cachimbo 

Parâmetro Unidades 
P1 P2 P3 P4 

C S C S C S C S 

Temperatura ºC 26.82 S/a 27.68 29.3 28.99 29.2 28.44 28.1 

Condutividade µS/cm 56 S/a 59 43.7 47 34.4 68 51.2 

Turbidez NTU 11.1 S/a 3.8 8.82 19.1 63.4 8.1 28.9 

STD mg/L 37 S/a 38 21.9 31 17.2 44 25.6 

pH (-) 6.03 S/a 5.35 6.54 5.68 6.18 5.52 6.18 

DBO mg/L 0.55 S/a 1.31 1.64 2.12 2.21 2.91 3.46 

OD mg/L 7.72 S/a 5.41 4.99 7.34 4.48 7.54 4.34 

Amônia mg/L 0.05 S/a 0.07 0.04 0.17 0.33 0.12 0.14 

Nitrito mg/L 0.007 S/a 0.008 0.005 0.007 0.004 0.007 0.006 

Nitrato mg/L 1.2 S/a 1.8 1.6 1.6 0.9 2.4 2.3 

Fósforo total mg/L 0.06 S/a 0.05 0.04 0.08 0.09 0.06 0.03 

Clorofila-a µg/L 0.29 S/a 0.22 <0.002 0.8 0.01 0.63 <0.002 

Coliformes 

totais 
NMP/100 mL 2419.6 S/a 1299.7 >2419.6 >2419.6 >2419.6 >2419.6 >2419.6 

Escherichia 

coli 
NMP/100 mL 304.4 S/a 111.2 1413.6 378.4 344.8 365.4 235.9 

DBO:Demanda Bioquímica de Oxigênio; OD: Oxigênio Dissolvido; C: período chuvoso; S: período de seca; S/a: sem água.  

Fonte: Autores, 2022. 

5.1.2 Córrego Sussuapara 

O Córrego Sussuapara também se localiza na região norte de Palmas, os resultados de 

suas análises da qualidade água pode ser visto na Tabela 3. As análises mostram que os 

parâmetros de turbidez, sólidos totais dissolvidos, DBO, oxigênio dissolvido, nitrito, nitrato e 

Clorofila a estão dentro dos padrões da Resolução CONAMA 357/2005 em todas as amostras 

e nos dois períodos climáticos. O pH equivale ao potencial hidrogeniônico de uma solução, 

onde indica a concentração da acidez ou basicidade de uma solução aquosa, no período chuvoso 

o parâmetro apresentou valores abaixo dos padrões permitidos.  

O fósforo total apresentou-se superior ao que se preconiza na legislação, nos pontos P5 

e P6, valores superiores desse parâmetro podem estar associados ao recebimento de efluentes 

domésticos, indústrias e pelo carreamento de nutrientes. Nesta microbacia foram localizados 

três pontos de lançamentos de águas pluviais e vários pontos de lançamentos de efluentes 

domésticos sem tratamento. Níveis elevados de fósforo no ambiente aquático podem 

desencadear o crescimento desordenado de microalgas e potencializar o processo de 

eutrofização. Esta microbacia recebe grande contribuição de redes de drenagem de águas 

pluviais e tubos de dreno, o que pode estar ligado a alteração nos parâmetros coliformes totais 

e Escherichia coli.    
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Tabela 3 - Qualidade da água do Córrego Sussuapara 

Parâmetro Unidades 
P5 P6 P7 

C S C S C S 

Temperatura ºC 27.63 S/a 27.79 27.7 28.46 26.4 

Condutividade µS/cm 104 S/a 26 20.11 27 23.64 

Turbidez NTU 1.7 S/a 0.4 3.19 1.6 6.74 

STD mg/L 67 S/a 17 10.05 0.018 11.8 

pH (-) 5.61 S/a 5.66 6.33 5.86 6.69 

DBO mg/L 2.3 S/a 0.35 1.01 1.67 0.96 

OD mg/L 6.67 S/a 6.74 5.7 7.58 5.55 

Amônia mg/L 0.11 S/a 0.04 0.04 <0.02 0.2 

Nitrito mg/L 0.007 S/a 0.006 0.004 0.06 0.006 

Nitrato mg/L 0.5 S/a 0.7 0.7 0.9 0.8 

Fósforo total mg/L 0.15 S/a 0.14 0.07 0.06 0.1 

Clorofila-a µg/L 0.36 S/a 0.55 <0.002 0.25 <0.002 

Coliformes totais NMP/100 mL >2419.6 S/a >2419.6 >2419.6 >2419.6 125.9 

Escherichia coli NMP/100 mL 1553.1 S/a 64.4 178.9 613.1 56.7 
DBO:Demanda Bioquímica de Oxigênio; OD: Oxigênio Dissolvido; C: período chuvoso; S: período de seca; S/a: sem água.  

Fonte: Autores, 2022. 

5.1.3 Córrego Brejo Comprido 

Na Tabela 4 demonstra-se os indicadores de qualidade da água do Córrego Brejo 

Cumprido. Os resultados mostram que o pH teve valores alterados em todas as amostras no 

período chuvoso, e no ponto P8 no período de seca, devido a diminuição do regime 

hidrográfico.  

O oxigênio dissolvido apresentou valores abaixo dos níveis estabelecidos na Resolução 

CONAMA 357/2005 no período de estiagem. Verificou-se valores alterados do parâmetro 

fósforo total nos pontos P9 e P10 no período de estiagem. Os coliformes totais tiveram acima 

de 1000 NMP/100 mL em todas as amostram durante o período chuvoso.  

 Esta microbacia é localizada na região central, acomoda um importante parque de lazer 

e recreação, em sua extensão existe um Lago artificial formado por intervenção antrópica, no 

qual funciona como bacia de contenção e recebe grande carga de lançamentos de drenagem de 

águas pluviais, carreamento de sedimentos e contribuição de vias urbanas. No local de coleta 

(P8) verificou-se várias habitações irregulares e lançamentos de efluentes domésticos 

clandestino as margens do córrego. Nesse sentido, verifica-se que as alterações nos parâmetros 

de qualidade da água estão relacionadas com as diversas atividades antrópicas desordenadas 

constatadas, embora a área conte com rede de esgoto e de águas pluviais ao longo de todo o 

trajeto do corpo d’água no perímetro urbano, além de contribuições à montante do Lago 

provenientes da área rural desassistida com a rede coletora de esgotamento sanitário.    
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Tabela 4 - Qualidade da água do Córrego Brejo Comprido 

Parâmetro Unidades 
P8 P9 P10 

C S C S C S 

Temperatura ºC 26.76 27.9 28.18 27.7 28.53 28.9 

Condutividade µS/cm 25 14.11 28 20.55 30 28.24 

Turbidez NTU 6.2 13.7 92 32.7 7.7 23.1 

STD mg/L 0.016 7.02 0.018 10.26 20 14.12 

pH (-) 5.58 5.83 5.47 6.13 5.57 6.43 

DBO mg/L 1.5 0.73 1.64 0.57 0.33 0.48 

OD mg/L 8 3.15 7.54 3.65 5.73 4.5 

Amônia mg/L 0.13 0.09 0.16 1.73 0.16 0.13 

Nitrito mg/L 0.007 0.003 0.008 0.002 0.007 0.004 

Nitrato mg/L 0.6 0.4 0.8 0.5 0.9 0.5 

Fósforo total mg/L 0.09 0.09 0.08 0.28 0.09 0.65 

Clorofila-a µg/L 0.42 <0.002 0.65 1.18 0.36 <0.002 

Coliformes totais NMP/100 mL >2419.6 103.5 >2419.6 135.3 >2419.6 47.1 

Escherichia coli NMP/100 mL 517.2 60.5 686.7 49.6 579.4 36.9 
DBO:Demanda Bioquímica de Oxigênio; OD: Oxigênio Dissolvido; C: período chuvoso; S: período de seca; S/a: sem água.  

Fonte: Autores, 2022. 

5.1.4 Córrego do Prata 

O Córrego do Prata é localizado no Plano Diretor Sul de Palmas, em anos anteriores 

esta microbacia foi receptora de efluentes de uma estação de tratamento de esgoto.  

Os resultados analíticos de qualidade da água podem ser visualizados na Tabela 5. As 

análises demonstram alterações do pH nos pontos P11 e P12 nos dois períodos climáticos, e no 

ponto P13 somente no período de estiagem, demostrando concentração de acidez na água. 

O Parâmetro de OD apresentou concentrações muito baixas no período de estiagem em 

todas as amostragens, chegando a 1,03 mg/L no Ponto P3, não alcançando os padrões 

estabelecidos na resolução. Foi observado alterações nos valores de fósforo total nos pontos 

P11 e P13 no período chuvoso. O parâmetro de coliformes totais apresentou níveis acima de 

1500 NMP/100 mL em todas as amostram e períodos. No ponto P13 o parâmetro Escherichia 

coli apresentou resultados acima dos limites permitidos nos dois períodos.  

O Córrego do Prata recebe drenagem de águas pluviais em vários pontos da sua 

extensão, o que pode interferir na qualidade da água sobretudo no período de estiagem, onde 

autodepuração natural é reduzida devido a diminuição do fluxo hidrográfico. Os demais 

parâmetros mantiveram-se dentro dos valores máximos permitidos pela Resolução CONAMA 

nº 357/2005 em ambas as estações. 
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Tabela 5 - Qualidade da água do Córrego do Prata 

Parâmetro Unidades 
P11 P12 P13 

C S C S C S 

Temperatura ºC 29.61 31.1 28.85 28.9 27.23 28.3 

Condutividade µS/cm 15 10.06 45 36.1 24 37.9 

Turbidez NTU 3.8 5.63 2.1 2.57 9.9 10.9 

STD mg/L 10 4.82 29 18 15 19 

pH (-) 4.51 5.03 4.79 5.56 4.88 6.32 

DBO mg/L 1.02 0.51 0.99 0.4 1.04 0.24 

OD mg/L 6.98 2.95 7.24 1.03 6.62 2.78 

Amônia mg/L <0.02 0.03 0.11 0.05 0.11 0.04 

Nitrito mg/L 0.007 0.006 0.006 0.006 0.005 0.003 

Nitrato mg/L 0.11 0.4 0.08 0.9 1 0.4 

Fósforo total mg/L 0.11 0.04 0.08 0.04 0.08 0.11 

Clorofila-a µg/L 0.28 <0.002 0.26 <0.002 0.08 0.2 

Coliformes totais 

NMP/100 

mL 
1553.1 1553.1 >2419.6 >2419.6 >2419.6 >2419.6 

Escherichia coli 
NMP/100 

mL 
140.3 52 436 436 1203.3 1413.6 

DBO:Demanda Bioquímica de Oxigênio; OD: Oxigênio Dissolvido; C: período chuvoso; S: período de seca; S/a: sem água.  

Fonte: Autores, 2022. 

5.1.5 Córrego Machado 

Na Tabela 6 pode ser visualizado os resultados analíticos realizados no Córrego 

Machado. Os dados apresentam as alterações nos parâmetros de qualidade da água: (a) oxigênio 

dissolvido, nos quatro pontos de coleta, no período de seca, quando há redução vazão; (b) 

fósforo total, no ponto P14, nas duas estações, e no ponto P16 na estação de seca; (c) Coliformes 

totais em todos os pontos, nos dois períodos analisados; e (d) E. coli no ponto P16, em ambas 

as estações, e no ponto P17 na estação de estiagem. As alterações na qualidade da água 

observadas nas análises estão relacionadas a presença de dejetos orgânicos que alteram as 

condições e padrões de qualidade da água em desconformidade com os requisitos para corpos 

d’água classe 2. Possivelmente essas alterações se devem a localização desta microbacia, que 

se encontra em uma região com alta taxa de ocupação e uso do solo, o que aumenta o nível de 

pressão antrópica provocada pelo desmatamento da mata ciliar e a deposição de resíduos sólidos 

e líquidos nas margens do corpo hídrico.  

Os demais parâmetros se mantiveram dentro dos valores aceitáveis preconizados na 

Resolução CONAMA 357/2005 em ambos os períodos.  
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Tabela 6 - Qualidade da água do Córrego Machado 

Parâmetro Unidades 
P14 P15 P16 P17 

C S C S C S C S 

Temperatura ºC 27.1 32.2 25.96 28.8 26.19 28.3 26.66 28.08 

Condutividade µS/cm 97 63.9 100 78.9 91 75.5 88 72.8 

Turbidez NTU 2.4 12.7 3.4 41.9 4.2 30.5 18.6 22.3 

STD PPM 62 31.9 65 39.5 58 37.8 57 36.4 

pH (-) 6.86 6.49 6.82 6.33 6.69 6.52 6.4 6.82 

DBO mg/L 1.21 0.31 2.19 0.82 2.93 1.41 1.87 1.22 

OD mg/L 5.37 4.29 7.88 2.31 7.67 4.46 5.81 4.8 

Amônia mg/L 0.33 0.14 0.43 0.27 0.2 0.1 0.2 0.2 

Nitrito mg/L 0.006 0.009 0.006 0.007 0.006 0.069 0.004 0.0091 

Nitrato mg/L 2.6 1.3 1.7 0.7 1.8 0.9 2.1 0.9 

Fósforo total mg/L 0.12 0.13 0.008 0.03 0.06 0.15 0.08 0.3 

Clorofila-a µg/L 0.05 0.2 0.26 0.39 0.18 <0.002 0.27 <0.002 

Coliformes 

termotolerantes 

NMP/100 

mL 
>2419.6 >2419.6 >2419.6 1413.6 >2419.6 >2419.6 >2419.6 >2419.6 

Escherichia 

coli 

NMP/100 

mL 
218.7 131.7 344.8 185 1046.2 686.7 >2419.6 1119.9 

DBO:Demanda Bioquímica de Oxigênio; OD: Oxigênio Dissolvido; C: período chuvoso; S: período de seca; S/a: sem água.  

Fonte: Autores, 2022. 

5.1.6 Córrego Santa Bárbara 

A Tabela 7 mostra os resultados das análises de água do Córrego Santa Bárbara, onde 

foram observados a desconformidade com a Resolução CONAMA nº 357/2005 nos parâmetros: 

(a) pH, DBO e OD no ponto P19, próximo a sua foz, na estação de seca; (b) fósforo total nos 

pontos P18 e P19 no período de estiagem; e (c) Coliformes totais nos pontos P18 e P19, nas 

duas estações. As alterações na qualidade da água estão relacionadas à alta concentração de uso 

e ocupação do solo, expansão urbana e lançamentos de água da rede de drenagem urbana na 

área de cabeceira e anterior a sua foz. Os valores de coliformes totais indicam a presença de 

lançamentos de esgotos domésticos juntamente com a rede de drenagem. 

Tabela 7 - Qualidade da água do Córrego Santa Barbara  

Parâmetro Unidades 
P18 P19 

C S C S 

Temperatura ºC 26.76 29.1 26.81 29.2 

Condutividade µS/cm 111 77.6 81 22.06 

Turbidez NTU 2.9 17.4 3.6 8.15 

STD mg/L 72 38.8 53 11.02 

pH (-) 6.91 6.65 6.88 5.76 

DBO mg/L 0.41 1.65 1.94 5.76 

OD mg/L 5.21 3.18 6.02 3.03 

Amônia mg/L 0.21 0.12 0.22 0.09 

Nitrito mg/L 0.006 0.004 <0.002 0.005 

Nitrato mg/L 2.1 0.6 1.8 1 

Fósforo total mg/L 0.08 0.04 0.09 0.09 

Clorofila-a µg/L 0.26 0.59 0.25 <0.002 

Coliformes totais NMP/100 mL >2419.6 >2419.6 >2419.6 >2419.6 

Escherichia coli NMP/100 mL 488.4 488.4 435.2 108.1 
DBO:Demanda Bioquímica de Oxigênio; OD: Oxigênio Dissolvido; C: período chuvoso; S: período de seca; S/a: sem água.  

Fonte: Autores, 2022. 
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5.1.7 Córrego Taquarí 

A Tabela 8 representa os resultados das análises de qualidade da água realizadas no 

Córrego Taquarí. Os dados demonstram que os parâmetros de turbidez, sólidos totais 

dissolvidos, nitrito, nitrato, fósforo total, Clorofila a e E. coli se mantiveram dentro dos valores 

permitidos na Resolução CONAMA 357/2005 em todos os pontos e períodos. Os parâmetros 

de DBO, OD e pH apresentaram resultados negativos no ponto P21 durante período de 

estiagem, neste ponto está localizado a foz do Córrego Santa Bárbara e, provavelmente, é 

responsável pelo aporte de nutrientes carreados pela rede de drenagem. No período seco o OD 

teve valor negativo no ponto P22.   

O parâmetro coliforme total apresentou-se acima dos valores estabelecidos pela norma 

em todos os pontos nas duas estações do ano, indicando presença de desejos orgânicos 

provenientes do lançamento de esgoto doméstico. 

Tabela 8 - Qualidade da água do Córrego Taquarí 

Parâmetro Unidades 
P20 P21 P22 

C S C S C S 

Temperatura ºC 27.19 S/A 26.57 28.7 26.74 29.7 

Condutividade µS/cm 30 S/A 20 9.88 48 17.79 

Turbidez NTU 1.4 S/A 4.3 12.3 5 12.5 

STD mg/L 20 S/A 13 4.93 32 8.9 

pH (-) 6.75 S/A 6.65 5.27 6.97 6.12 

DBO mg/L 1.51 S/A 1.34 5.27 2.4 0.23 

OD mg/L 6.19 S/A 7.89 0.49 7.69 3.7 

Amônia mg/L 0.16 S/A 0.16 <0.02 0.15 0.04 

Nitrito mg/L 0.006 S/A 0.003 0.014 0.005 0.004 

Nitrato mg/L 0.8 S/A 0.6 0.4 1.3 0.6 

Fósforo total mg/L 0.08 S/A 0.06 0.03 0.09 0.02 

Clorofila-a µg/L 0.4 S/A 0.21 0.2 0.1 0.002 

Coliformes totais NMP/100 mL >2419.6 S/A >2419.6 >2419.6 >2419.6 >2419.6 

Escherichia coli NMP/100 mL 298.7 S/A 325.5 111.2 206.4 686.7 
DBO:Demanda Bioquímica de Oxigênio; OD: Oxigênio Dissolvido; C: período chuvoso; S: período de seca; S/a: sem água.  

Fonte: Autores, 2022. 

5.1.8 Córrego Cipó 

A Tabela 9 apresenta os resultados analíticos de qualidade da água do Córrego Cipó, 

onde pode ser observado que, dentre os parâmetros analisados, os coliformes totais encontram 

acima dos níveis preconizados pela Resolução CONAMA nº 357/2005 no período chuvoso. 

Verificou-se a presença de Escherichia coli no ponto P24 no período chuvoso. Essas 

ocorrências indicam presença de dejetos orgânicos oriundos do lançamento de esgotos 

domésticos.  
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No período seco não havia fluxo hídrico nos pontos de análise, impossibilitando a coleta, 

pois o Córrego Cipó é um corpo d’água intermitente.  

Tabela 9 - Qualidade da água do Córrego Cipó 

Parâmetro Unidades P23 P24 

  C S C S 

Temperatura ºC 27.72 S/A 26.94 S/A 

Condutividade µS/cm 39 S/A 45 S/A 

Turbidez NTU 0.6 S/A 3.9 S/A 

STD mg/L 26 S/A 30 S/A 

PH Escala 6.71 S/A 6.99 S/A 

DBO mg/L 1.61 S/A 1.71 S/A 

OD mg/L 5.22 S/A 7.72 S/A 

Amônia mg/L 0.15 S/A 0.16 S/A 

Nitrito mg/L 0.004 S/A <0.002 S/A 

Nitrato mg/L 0.8 S/A 0.9 S/A 

Fósforo total mg/L 0.06 S/A 0.08 S/A 

Clorofila-A µg/L 0.13 S/A 0.18 S/A 

Coliformes t. NMP/100 mL >2419.6 S/A >2419.6 S/A 

Escherichia coli NMP/100 mL 920.8 S/A 1046.2 S/A 
DBO:Demanda Bioquímica de Oxigênio; OD: Oxigênio Dissolvido; C: período chuvoso; S: período de seca; S/a: sem água.  

Fonte: Autores, 2022. 

5.1.9 Condições e Padrões de qualidade da Resolução CONAMA n° 357/2005  

Os resultados analíticos das análises laboratoriais realizadas em todos os córregos 

urbanos do estudo, mostram que em ambas as estações climáticas, os parâmetros de turbidez, 

sólidos totais dissolvidos, nitrito, nitrato e Clorofila a, foram positivos conforme os padrões 

estabelecidos na Resolução CONAMA nº 357/2005 para águas doces classe 2.  

A turbidez teve aumento na maioria dos pontos analisados durante o período de 

estiagem, o nitrito e nitrato variaram em pequenas proporções entre as campanhas. Esses 

parâmetros são suscetíveis a variações ao longo do tempo, o que pode ser relacionado índices 

de precipitações e alterações naturais dos corpos d'água (Peluso et. al., 2021).  

O parâmetro sólidos totais dissolvidos é um indicador de qualidade que determina os 

níveis de substâncias filtráveis orgânicas e inorgânicas encontradas em corpos hídricos. O 

coeficiente de extinção luminosa (k) é uma função dos sólidos totais e da concentração da 

Clorofila a, que refletem a dispersão e adsorção por partícula (Kim et. al., 2021). A Clorofila 

a é um parâmetro indicador de biomassa fitoplanctônica na água, no qual revela o crescimento 

de algas e cianobactérias devido ao fortalecimento por nutriente. Peluso et. al., (2021) tiveram 

concentrações semelhantes de Clorofila a, no qual demonstraram uma boa qualidade de água 

do corpo hídrico.  
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Os Córregos Santa Barbara e Taquarí tiveram valores alterados de demanda bioquímica 

de oxigênio no período de seca, nos pontos P19 e P21. A DBO é um indicador de qualidade da 

água que demonstra o consumo de oxigênio por microrganismos durante a decomposição de 

matéria orgânica. Dalu et. al., (2021) tiveram resultados semelhantes desse parâmetro nas 

análises de qualidade da água do Rio Sarawak, que mostraram uma tendência crescente para a 

jusante do corpo hídrico.  

No Brasil não existe na legislação um padrão definido para a temperatura dos corpos 

hídricos, apenas para o lançamento de efluentes, onde o limite fixado pela Resolução 

CONAMA nº 430/2011 é de até 40°C. A temperatura dos corpos d’água é um parâmetro físico, 

quando associado a outros parâmetros pode indicar a qualidade da água, como um fator 

limitante à vida aquática (Percebon et. al., 2005).  

Segundo Piratoba et. al., (2017) não existe um padrão de condutividade elétrica definido 

para os corpos hídricos, no entanto, em águas naturais a condutividade apresenta proporções 

entre 10 a 100 μS/cm, em águas poluídas por esgotos domésticos ou industriais, as proporções 

podem chegar até 1000 μS/cm.  

No período chuvoso as concentrações de coliformes totais foram acima de 1.000 

NMP/100 mL, em todos os pontos analisados. No período de seca este parâmetro apresentou 

concentrações abaixo de 1.000 NMP/100 mL apenas nos pontos P7, P8, P9 e P10. Segundo a 

Resolução CONAMA nº 357/2005 a concentração de coliformes totais para corpos d’água 

classe 2, não deve exceder um limite de 1.000 NMP/100 mL em 80% ou mais, de pelo menos 

6 (seis) amostras coletadas durante o período de um ano, com frequência bimestral; a 

Escherichia coli pode ser utilizada no lugar do parâmetro de coliformes totais de acordo com 

limites estabelecidos pelo órgão ambiental competente. O lançamento de redes de drenagem de 

águas pluviais e despejo de esgotos nos corpos hídricos são fatores que contribuem para a 

entrada de microrganismos nesses ambientes (Ribeiro et al., 2017).  

5.2 Aspectos Hidrológicos    

Neste item serão demonstradas as variações dos aspetos hidrológicos dos córregos do 

estudo, durante o período chuvoso e de estiagem.  

A Tabela 10 mostra os resultados das medições de vazões. Os seguimentos demonstram 

que durante o período chuvoso havia fluxo hidrográfico em todos os pontos de medições de 

vazões, entretanto, no período de estiagem houve redução significativa dos volumes 

hidrológicos sobretudo no Córrego Cipó. Segundo relatos dos moradores locais há mais de 20 
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anos o córrego seca completamente nesse período. Esses aspectos caracterizam o curso d’água 

como intermitente, ou seja, apresenta fluxo de água apenas no período chuvoso.  

Tabela 10 - Medição de vazões (Q).  

Corpo hídrico Período Chuvoso (m3/s) Período de Seca (m3/s) 

Córrego Cachimbo 0.1392 0.0200 

Córrego Sussuapara 0.1854 0.0353 

Córrego Brejo Comprido 0.7065 0.1194 

Córrego do Prata 0.2770 0.0880 

Córrego Machado 0.2211 0.0435 

Córrego Santa Barbara 0.1857 0.0145 

Córrego Taquarí 0.2169 0.0001 

Córrego Cipó 0.5286 S/F 

S/F: sem fluxo.  

Fonte: Autores (2022) 

 

A tendência de redução das vazões dos corpos hídricos pode estar correlacionada, em 

partes, pela redução do regime chuvoso. Entretanto, existe a possibilidade de que as vazões 

mínimas dos corpos hídricos correntes reflitam as condições de recarga dos aquíferos 

durante o período de estiagem, desta forma, o regime de chuvas, as condições de 

infiltrabilidade, o uso e ocupação do solo e as características fisiológicas da cobertura 

vegetal, influenciam diretamente nos aspectos hidrológicos dos corpos d’água (Santos et al., 

2010).   

5.3 Análise Multitemporal da Evolução do Uso e Ocupação do Solo (1988-2020)   

Neste tópico serão apresentados os resultados da análise espaço-temporal das 

transformações de uso e cobertura do solo das microbacias hidrográficas do estudo, nos 

períodos de 1988, 1999, 2010 e 2020.  

Cabe destacar a seguinte circunstância para as imagens classificadas da Plataforma 

MapBiomas referente ao ano de 1988, neste período as imagens do Satélite Landsat 5 possuíam 

menor número de bandas espectrais e resolução espacial menos detalhista, o que pode provocar 

inconsistência na classificação de algumas áreas. Segundo Prado et al. (2009) esta confusão dos 

catalogadores é resultado da similaridade espectral existente entre algumas áreas, foi possível 

averiguar que os erros mais frequentes estavam contidos no comportamento espectral dos pixels 

ao atribuir a cobertura temática “Área não Vegetada” como pertencentes à classe “Área 

Urbanizada”, conforme demonstrado na Figura 9. 
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Figura 9 – Confusão dos classificadores imagem do Satélite Landsat 5 (1988) 

 

Fonte: Autora (2022). 

5.3.1 Microbacia Hidrográfica do Córrego Cachimbo 

Na Figura 10 é possível observar as mudanças de cobertura e uso do solo na Microbacia 

Hidrográfica do Córrego Cachimbo. No ano de 1988 a classe “Formação Florestal” 

correspondia a 39,20%, “Pastagem” 7,86%, “Área Urbanizada” 28,68% e “´Área não 

Vegetada” 28,68% da área total da microbacia. Em 1999 as classes “Formação Florestal e 

Pastagem” tiveram redução de seus percentuais. Em 2020 a área urbana passou a abranger 

67,50% da área total, enquanto as formações florestais reduziam a 22,45%. 

Figura 10 - Uso e ocupação do solo na Microbacia Hidrográfica do 

Córrego Cachimbo (1988, 1999, 2010 e 2020) 

 
                        Fonte: Autora (2022). 
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No Gráfico 1 é demonstrado de forma dinâmica as variações do uso e ocupação do solo 

da microbacia ao longo dos anos. Podendo ser observado que à medida que a classe “Formação 

Florestal” reduziu, a classe “Área Urbanizada” teve aumento significativo.  

Gráfico 1 - Uso e ocupação do solo na Microbacia do Córrego Cachimbo por Km² 

 
                       Fonte: Autora (2022) 

5.3.2 Microbacia Hidrográfica do Córrego Sussuapara 

Na Figura 11 é possível observar a evolução do uso e cobertura do solo na Microbacia 

Hidrográfica do Córrego Sussuapara. No ano de 1988 mais da metade da microbacia era 

compreendia pela classe “Formação Florestal”, em 1999 a classe passou a corresponder a 

21,42% e a área urbana a 76,42%. A classe “Área Urbanizada” teve comportamento crescente 

no decorrer dos anos, abrangendo 84,86% em 2010 e 85,64% em 2020.  
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Figura 11 - Uso e ocupação do solo na Microbacia Hidrográfica do Córrego Sussuapara 

(1988, 1999, 2010 e 2020) 

 
                       Fonte: Autora (2022). 

O Gráfico 2 demonstra as faixas de variações do uso e ocupação do solo na microbacia 

nos períodos de análise. As classes “Pastagem e Área não Vegetada” não apresentam mudanças 

significativas nos períodos avaliados. 

Gráfico 2 - Uso e ocupação do solo na Microbacia do Córrego Sussuapara por Km² 

 
                      Fonte: Autora (2022). 
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5.3.3 Microbacia Hidrográfica do Córrego Brejo Comprido 

As mudanças de cobertura e uso do solo na Microbacia Hidrográfica do Córrego Brejo 

Comprido no decorrer dos anos de 1988, 1999, 2010 e 2020 pode ser observada na Figura 12. 

Em 1988 grande parte da área da microbacia possuía vegetação nativa. Em 1999 teve maior 

variação nas classes “Formação Florestal e Área Urbanizada” que passaram a corresponder a 

60.16% e 32.96% respectivamente, e houve o surgimento da classe “Corpos D’água” com 

0.36%.  

Figura 12 - Uso e ocupação do solo na Microbacia Hidrográfica do Córrego Brejo Comprido 

(1988, 1999, 2010 e 2020) 

 
                    Fonte: Autora (2022). 

Em 2010 as classes apresentaram pequenas alterações.  Pode se constatar que na 

Microbacia do Córrego Brejo as variações maiores foram entre as classes “Formação Florestal 

e Área Urbanizada”, que passaram a corresponder em 2020 a 55.07% e 38,70% na área total, 

conforme Gráfico 3. 
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Gráfico 3 - Uso e ocupação do solo na Microbacia do Córrego Brejo Comprido por Km² 

 
                       Fonte: Autora (2022). 

5.3.4 Microbacia Hidrográfica do Córrego do Prata 

A evolução do uso e cobertura do solo na Microbacia Hidrográfica do Córrego do Prata 

pode ser visualizada na Figura 13. Os resultados mostram que entre os anos de 1988 e 1999 as 

classes com mais variações foram “Formação Florestal e Área Urbanizada”. Em 2020 a classe 

“Área Urbanizada” passou a corresponder 61,95% da área total, e a classe “Formação Florestal 

35.62%.  

Figura 13 - Uso e ocupação do solo na Microbacia Hidrográfica do Córrego do Prata (1988, 

1999, 2010 e 2020) 

 
                       Fonte: Autora (2022). 
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Gráfico 4 - Uso e ocupação do solo na Microbacia do Córrego do Prata por Km² 

 
                      Fonte: Autora (2022). 

5.3.5 Microbacia Hidrográfica do Córrego Machado 

Na Figura 14 é possível observar o avanço do uso e ocupação do solo na Microbacia 

Hidrográfica do Córrego Machado. Em 1998 a microbacia dispunha 71,22% da classe 

“Formação Florestal”, 11,07% da classe “Pastagem”, 15,72% da classe “Área Urbanizada” e 

classe 1,91% “Área não Vegetada”. 

Em 1999 grande parte das formações florestais foram transformadas em área urbana, e 

essa tendencia se manteve até o ano 2020 conforme Gráfico 5.  

Figura 14 - Uso e ocupação do solo na Microbacia Hidrográfica do Córrego Machado (1988, 

1999, 2010 e 2020) 

 
                             Fonte: Autora (2022). 
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Gráfico 5 - Uso e ocupação do solo na Microbacia do Córrego Machado por Km² 

 
                       Fonte: Autora (2022). 

5.3.6 Microbacia Hidrográfica do Córrego Santa Bárbara 

A evolução do uso e cobertura na Microbacia Santa Barbara pode ser visualizada na 

Figura 15. A classe “Formação Florestal” abrangia 62,79% da área em 1988, porém, teve 

tendências de redução correspondendo a 38,24% (1999), 34,06% (2010) e 27,22% (2020). Á 

área urbana correspondia a 23,35% em 1988, ela teve tendencia crescente nos períodos 

analisados, correspondendo a 48,04% da área total em 2020. As classes “Pastagem e Corpos 

D’água” abrangeram pequenas áreas nos períodos de análise e tiveram pouca influência nas 

transições. 

Figura 15 - Uso e ocupação do solo na Microbacia Hidrográfica do Córrego Santa Bárbara 

(1988, 1999, 2010 e 2020) 

 
                      Fonte: Autora (2022). 
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Gráfico 6 - Uso e ocupação do solo na Microbacia do Córrego Santa Barbara por Km² 

 
                       Fonte: Autora (2022). 

5.3.7 Microbacia Hidrográfica do Córrego Taquarí 

As variações de uso e ocupação do solo na Microbacia do Córrego Taquari são 

demonstradas na Figura 16 e Gráfico 7. Em 1988 a classe “Formação Florestal” correspondia a 

69.46%, durante os anos teve redução contínua de sua área. Em 2020 a área urbana abrangeu 

5,35%, da microbacia, e áreas não vegetadas 15,51%. A classe “Pastagem” teve pequenas 

variações. Não houve aparição de lagos. 

Figura 16 - Uso e ocupação do solo na Microbacia Hidrográfica do Córrego Taquarí (1988, 

1999, 2010 e 2020) 

 
                      Fonte: Autora (2022). 
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Gráfico 7 - Uso e ocupação do solo na Microbacia do Córrego Taquarí por Km² 

 
                      Fonte: Autora (2022). 

5.3.8 Microbacia Hidrográfica do Córrego Cipó 

Na Figura 17 é possível observar as variações de uso e cobertura na Microbacia do 

Córrego Cipó entre 1988 a 2020. A classe “Formação Florestal” teve tendência redutiva, porém, 

permaneceu predominante, abrangendo mais de ½ da área durante todos os anos. A classe 

“Pastagem” teve variações moderadas. A área urbana correspondeu a 16,16% em 2020 e 

superfícies não vegetadas abrangeu 5,7% da área total.  

Figura 17 - Uso e ocupação do solo na Microbacia Hidrográfica do Córrego Cipó (1988, 

1999, 2010 e 2020) 

 
                        Fonte: Autora (2022). 
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A classe “Corpos D’água” teve variação ínfima, não alcançando 0,1% da área, não sendo 

destacada, conforme Gráfico 8. 

Gráfico 8 - Uso e ocupação do solo na Microbacia do Córrego Cipó por Km² 

 
                       Fonte: Autora (2022). 

5.3.9 Áreas de Preservação Permanente – APP das Microbacias Hidrográficas 

Neste subitem serão apresentados os resultados da análise espaço-temporal da dinâmica 

da evolução de uso e cobertura do solo nas Áreas De Preservação Permanentes – APP das 

microbacias hidrográficas do estudo, nos períodos de 1988, 1999, 2010 e 2020. A soma de todas 

as APPs corresponde a uma área total 22,81 km².  

Na Figura 18 demonstra-se o uso e cobertura do solo nas Áreas De Preservação 

Permanentes – APP das microbacias referente ao ano de 1988. Nessa época a classe “Formação 

Florestal” abrangia 88,68% das áreas de preservação permanente – APP das microbacias, 

seguida pela classe “Pastagem” com 6,51 %, “Área Urbanizada” com 2,27 % e “Área não 

Vegetada” com 2,44 %.  
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Figura 18 - Uso e ocupação do solo nas APPs das microbacias no ano de 1988 

 
                      Fonte: Autora (2022). 

A evolução do uso e ocupação do solo nas APPs em 1999 pode ser visualizada na Figura 

19. Nesse período ocorreu o surgimento de superfícies alagadas, tais como, rios, lagos e 

reservatórios, correspondendo a 1,15%, sendo caracterizada pela classe “Corpos D’água”. 

Houve redução das classes “Formação Florestal” e “Área não Vegetada”, que passaram a 

corresponder 75,07% e 2,01% respectivamente. As classes “Área Urbanizada” e “Pastagem” 

tiveram tendencia crescente nesse período, correspondendo a 14,34% e 7,33%, nessa ordem.  

Figura 19 - Uso e ocupação do solo nas APPs das microbacias no ano de 1999 

 
                       Fonte: Autora (2022). 
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A Figura 20 mostra a dinâmica da evolução do uso e ocupação do solo nas APPs no 

período de 2010. A classe “Área Urbanizada” manteve comportamento progressivo, 

correspondente a 17,43 %, diferente da classe “Formação Florestal” que reduziu para 73,35%. 

As demais classes tiveram pequenas variações.  

 Figura 20 - Uso e ocupação do solo nas APPs das microbacias no ano de 2010 

 
                       Fonte: Autora (2022). 

 

 No ano de 2020 a vegetação nativa das APPs das microbacias hidrográficas continuou 

a sofrer regressão de sua área, onde a classe “Formação Florestal” abrangeu 70,90%. Verificou-

se que a classe “Área Urbanizada” manteve a conduta expansiva, ocupando 19,39%. As classes 

“Pastagem” e “Área não Vegetada” apresentaram pequenas alterações, contemplando 6,59% e 

2,1% da APP. Nesse período a classe “Corpos D’água” compreendeu 0,93%. A evolução do 

uso e cobertura em 2020 esta demonstrada na Figura 21.  
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Figura 21 - Uso e ocupação do solo nas APPs das microbacias no ano de 2020 

 
                      Fonte: Autora (2022). 

 

O Gráfico 9 demonstra a proporção das mudanças do uso e ocupação do solo nas Áreas 

De Preservação Permanentes – APP nas microbacias hidrográficas em km²/classe, no período 

de 1988-2020. 

Gráfico 9 - Uso e ocupação do solo nas APP por Km² 

 
                       Fonte: Autora (2022). 
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5 CONCLUSÕES 

Com base nos resultados, os córregos urbanos possuem concentrações de Escherichia 

coli e coliformes totais acima dos limites permitidos para corpos d’água classe 2, conforme 

estabelece a Resolução CONAMA 357/05. No período de estiagem demostram o oxigênio 

dissolvido apresentou valores negativos na maioria dos córregos. 

  Os resultados do monitoramento dos aspectos hidrológicos mostram que a variação 

sazonal exerce grande influência no fluxo de água dos corpos hídricos durante o período de 

estiagem. No entanto, além das variações climáticas, o uso e ocupação do solo impactam no 

ciclo hidrológico e na qualidade da água, pois o escoamento superficial, evapotranspiração, 

infiltração, propagação de sedimentos, recarga, drenagem e descarga de esgoto são condições 

que alcançam e intervém nas bacias hidrográficas. Os efeitos combinados da poluição urbana e 

do desempenho hidrológico, demonstram que os serviços dos ecossistemas aquáticos, como 

absorção de nutrientes ou decomposição de matéria orgânica, são prejudicados por entradas de 

esgoto, especialmente no caso de esgoto não tratado, levando ao empobrecimento da biota 

dentro desses ecossistemas, por fim, constata-se que o estresse hidrológico aumenta o impacto 

da poluição urbana. As variações hidrológicas desencadeiam efeitos na estrutura e 

funcionamento dos sistemas fluviais, na diminuição do fluxo aumenta-se a exposição dos raios 

ultravioleta, maior variação da temperatura da água, maiores concentrações de nutrientes, 

poluentes e disseminação de espécies não nativas, com efeitos em cascata sobre a 

biodiversidade aquática, terrestre e no funcionamento do ecossistema. 

Os resultados da avaliação da evolução espaço-temporal do uso e ocupação do solo nas 

microbacias hidrográficas urbanas demonstraram que os percentuais vegetacionais da classe 

“Formação Florestal” sofreram maiores variações com taxas negativas, a classe teve redução 

de áreas continuamente no decorrer dos anos, após a implantação do Município de Palmas – 

TO. A classe “Área Urbanizada” apresentou as maiores taxas de expansão de ocupação do solo.  

A expansão urbana se sobrepôs em áreas com alto grau de proteção do solo. A ocupação 

urbana desordenada nas áreas de preservação ambiental - APP pode comprometer a capacidade 

de suporte ambiental oferecida pelas microbacias hidrográficas urbanas.  
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